
BizNet Software, Inc Confidential© 2014 BizNet Software, Inc. All rights reserved.
Last Revised: Thursday, April 12, 2018

BizInsight 5.0.35.2

Installation Guide

This document applies to the following ERP system(s):

Sage 100 (ProvideX and SQL)

Installation Overview

Creating and installing a new BizInsight environment requires the following steps.  If
you are upgrading your BizInsight installation to a new version, please refer to the
document titled "Applying Updates".

If you are installing on a Terminal Services or Citrix server, please also refer to the
document titled "Citrix Terminal Sevices Deployment Guide" for steps specific to that
environment.

IMPORTANT

BizNet Software strongly discourages running BizInsight over a WAN or VPN con-
nection. Performance of the product can be greatly diminished in this configuration
because of the volume of data being transferred and bandwidth limitations. Cus-
tomers may implement the product in this manner but Support for performance
issues will not be provided until the issue can be demonstrated to exist in a non-
WAN/VPN configuration.

Notice  Screenshots in this document are provided as examples and may not exactly
match what you see in your environment or the values displayed in the screenshots
may not be appropriate for your implementation. Be sure to read all instructions com-
pletely for guidance on what values you may need to enter.



 System Requirements 

Prior to running the content installer, confirm that the following system require-
ments are satisfied. If any of the following are not satisfied, this installer tool cannot
be used.

l  IMPORTANT  For Sage 100 ProvideX customers, the installer must be run on
the server where the Sage 100 ProvideX data files reside.

l The server operating system is one of the following:
o Windows Server 2003 R2 (SP2 or later)

o Windows Server 2008 (SP2 or later)

o Windows Server 2008 R2

o Windows Server 2012

l The user performing the installation has Administrator privileges

l Existing SQL Server installations that can be used are SQL Server 2008, SQL
Server 2008 R2, SQL Server 2012, SQL Server 2014, and SQL Server 2016. If
the existing SQL Server installation is not one of the supported versions, use the
Content Installer to install a side-by-side SQL Server 2008 R2 Express instance.

WARNING

If the server has SQL Server 2016 installed, the Content Installer may fail on
two steps. The following workarounds can be used to resolve these issues if
they occur:

KBA-01144-W3R9R4 - An error occurred while installing the BizInsight and
BizInsightDB databases -- This error occurs when using an existing SQL Server
instance instead of letting the Content Installer install a 2008 R2 Express Edi-
tion and the server OS is Windows Server 2012.

KBA-01149-Z4J7H1 - System.IO.FileNotFoundException: Could not load file or
assembly 'Microsoft.SqlServer.ConnectionInfo' - This issue only occurs if an
existing SQL 2016 instance is used and the server has never had any earlier ver-
sions of SQL installed.

l The C:\ drive must have at least 5 GB of available space for the SQL Server
installation (if an existing SQL installation cannot be used)
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l The server is NOT a domain controller.
In the event the server is a domain controller, a supported version of SQL Server
and Reporting Services must be installed manually before running the Content
Installer. Example installation steps can be found in the document titled
"Installing SQL Server and Reporting Services".

l If the Content Installer will not be used to install an Express edition of
SQL Server and Reporting Service, the server must have a SQL database
engine installed.

l If using an existing SQL Server installation, the Windows log in of the user per-
forming the installation must have sysadmin rights to the SQL server install-
ation.
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Locate Installation Files

In preparation for installation, download the files that will be required for install-
ation from the BizNet Software portal, (http://biznet.flexnetoperations.com).   All
files can be found under "Browse My Software and Documentation".

Following are the files you will need to download:

l BizInsight 5.0.35.2

l BizInsight Tools.zip - this download file contains several tools that you might
need to use during implementation. It can be found with the BizInsight product
download file.

l BizContent - download all BizContent files to which you are entitled (required)

l SQL Server 2008 R2 Installer (required)

http://biznet.flexnetoperations.com/
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Save these files to any network location that is accessible from both the server and
the client workstations.  Throughout the documentation you will be instructed to
access the contents of these different zip files.
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Installation Activities for the Server
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Step 1: Create Shared Directory

Create a folder on your server or any network location that will be accessible by the
BizInsight users.  Copy the BizInsight license to this folder.

You may want to create two subdirectories, one for Admin files and the second for
Configuration files for more granular security control.  BizInsight users must have
modify rights to the config files but will only need read rights to the admin files. 
Copy the BizInsight license to the Admin folder if you choose to use this folder struc-
ture.

The Admin Tool, which will be used later, will configure sharing and security per-
missions of this directory for the BizInsight end users.

 IMPORTANT  If you are upgrading from a V4 version of BizInsight and want to run
your V4 reports without converting them to V5 functions, you must copy your BizFunc-
tions.xml to the content shared directory. See "Converting V4 Reports to BizInsight
5.0 " on page 141 for more information about running V4 reports in V5.
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Step 2: Run Content Pack Installer

Each content pack comes with an installer package that needs to be run on the server
that will be used to host Microsoft SQL Server Reporting Services, a required element
of a BizContent installation. 

 IMPORTANT  For Sage 100 ProvideX customers, this installer must be run on the
server where the Sage 100 ProvideX data files reside. If you intend to use an existing
SQL Server installation and Reporting Services instance, the content installer must be
run on the database server or a server where a SQL database engine has been
installed. It is not designed to be run from a client workstation.

1. Browse to the extract directory and double-click on the file named setup.exe.

2. The Welcome dialog will open.  Click Next.
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3. Review the End User License Agreement and if you agree to the terms, check
the I accept the terms in the License Agreement checkbox and click Next.
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4. Click on the desired Setup Type button.

Custom setup type options that are available:
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5. Click Install.

6. Click Yes to any User Account Control messages.

7. When the installer completes, an icon will exist on the desktop if you did not
disable the creation of shortcuts.

8. Double-click the shortcut on the desktop to launch the content installer.  If
you chose a Custom installation and disabled the creation of shortcuts, you
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must browse to the directory to which the content installer files were
extracted and double-click the BizNet Content Installer.exe.

9. The content installer will inspect the server and determine what elements
might already exist and indicate their presence.  The following screenshot
illustrates a system that has not had any content previously installed by a
content installer.

If you are installing content for Sage 100 ProvideX, the options will be slightly
different.
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Step 3: Automatic Install

This section describes installing using the Automatic Install button. For more details
or to install manually, see "Content Installer Manual Install Steps" on page 165 in the
Appendices section.

1. Clicking on Automatic Install will open a prompt to designate a folder
location.  Click on the Browse button and browse to the folder that will be
used as the shared directory for BizInsight.  

If you chose to create separate folders for the admin files and config files,
choose the config folder for the path.

Click OK.

2. You may be asked to enable the local Administrator account. Click OK,
Thanks, even if you know that the Administrator account is enabled.

3. The installer will ask whether you are using a 32-bit version of Sage 100 or a
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64-bit version. Choose the appropriate button.

 IMPORTANT  This question controls whether a 32-bit a 64-bit version of SQL
Server is installed. SQL Server can only access and use ODBC drivers that are
the same bitness. If you do not know whether your Sage 100 installation is
using a 32-bit or 64-bit ODBC driver, click I don't know and the installation will
be canceled. You will need to ascertain that information before the
installation can proceed.

4. If the Content Installer detects existing instances of SQL Server Reporting
Services installed on the local server machine, the following dialog will
display giving you the option to use the existing installation or to install a side
by side installation. 
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Option Description

Click here to start a side
by side installation of
SQL Server 2008 R2
Express

The side-by-side option is the recommended option to ensure
that all configuration changes needed for BizInsight purposes do
not interfere with other applications that may be using SQL or
Reporting Services.

Click here to use a
currently installed SQL
Server that you have
checked above

Use this button to specify that the installer use a detected
existing instance. Be sure to check the checkbox next to any
detected instance before using this button.

 IMPORTANT   If Sage 100 is using a 64-bit ODBC driver and an
existing 32-bit SQL instance is detected, do not choose that
existing instance. Instead, choose to do a Side-By-Side
installation of SQL Server. A 64-bit ODBC driver cannot be used
by a 32-bit SQL Server instance.
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Option Description

Click here to override and
enter your Sql Server
information

Use this button If you need to specify a different port or want to
use HTTPS for secure communications or your existing
installation is not detected.

When this button is clicked, a warning will display to emphasize
the requirement that the content installer must be run on a
server with a SQL database engine installed. Click OK to clear the
message.

In the Connection String for SQL Server field, enter a valid
connection string for the SQL Server instance to which the
Content Installer should install the SQL MetaData databases.
Use theWindows Authentication Example or the SQL Server
Authentication Example buttons to populate the connection
string with sample syntax. Be sure to change the values to
values valid for your environment.

In theWeb URL for Report Server field, enter theweb service
URL for the Reporting Services site to which Content Installer
should deploy the content RDLs.

If no Reporting Services Server is detected, the process automatically installs
SQL Server 2008 R2 Express with Advanced Services and uses “BIZNET” as the
default Report Server instance name.
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 IMPORTANT  IF an existing reporting services installation that you want to use
is not detected by the installer or you are not able to use the Override option,
contact BizNet Software Support for assistance.

If you get the following error after selecting the side by side installation,
verify that you have internet access.

If the side-by-side installation fails, contact BizNet Software Support for
assistance.

5. For customers installing Sage 100 ProvideX content, the Link Servers dialog
will open. This step will create ODBC data sources and Linked Servers for each
Sage 100 company from which data will be retrieved using BizInsight. Sage 100
SQL customers can skip forward to the next step, Content Deployment.
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6. You will work through this dialog starting with the Stage1 section (upper left).

a. Stage 1: Setup Driver
The installer will try to automatically detect the ProvideX ODBC driver
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If the driver is not found, click on the Browse button to browse to the
directory in which the driver is located. Or manually enter the path.

b. Stage 2: Database Location
The installer will try to automatically identify the location of the MAS90
company data directories.

 CRITICALLY IMPORTANT  If the detected database location is a UNC
path or a mapped drive path, you must go to Task Manager and end task
the Content Installer. See "Adjusting the Sage 100 ODBC paths" on page
119 for instructions on how to change the detected paths to a local
directory on the server. If this installation is being done on a server that
is not where the Sage 100 ProvideX data is located, you must perform
the installation on the Sage 100 data server.

If the installer cannot find the directories, click on the Browse button
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and browse to the directory that contains the SAGE 100 company
database directories (MAS_XXX). This location should be a local drive,
not a mapped drive or a UNC path.

c. Stage 3: Database Administration
Provide a SAGE 100 login id and password with rights to all companies
from which data will be retrieved using BizInsight. BizNet recommends
creating a login id for BizInsight reporting purposes and using this login
id instead of using an existing user’s login and password that could be
changed or deleted in the future.

d. Stage 4: Created File Details (Optional)
This section allows you to override the default file location and file
names that the tool can create for the next installation steps.
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e. Stage 5: Detect and Stage 6: Create
Use this section to automatically detect existing Sage 100 companies and
select which ones to setup for BizInsight reporting.
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The Check Database For Companies button will load all Sage 100
companies into the Stage 5: Detect pane.

The Add All Detected Company Codes button will add all detected
companies to the Stage 6: Create pane.

To add only certain companies for BizInsight reporting, check the
checkbox next to the company code in the Stage 5: Detect pane and
then click the Add Selected Company Codes button.
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Use the Clear Detected Codes button to start over.
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f. Choose OS Type
Select the appropriate radio button to indicate the bitness of the server
hardware, 32-bit or 64-bit.

g. Registry Entries and Linked Servers
Use these options to control the next installation steps. Make sure the
Create File option is selected. This will create files in the directory
specified in the Stage 4 section. You will execute these files yourself
when the content installer completes.

h. Click on the Start Process button.

You will received the following message when the Create Files option
is selected. Click Yes.

A Windows Explorer window will open to the directory containing the
files that were created.
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i. Open the CreateODBCDataSources.reg file with Notepad.

j. Search for pvxodbc.dll and check to see if there is a single back slash
preceding the file name or two back slashes. If there is only a single
back slash, do a search and replace of \pvxodbc.dll with \\pvxodbc.dll.

k. Save the file, being sure to preserve the .reg extension, then double-
click to create the ODBC data sources.
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l. Open SQL Server Management Studio (Start > Programs > Microsoft
SQL Server version > SQL Server Management Studio)
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m. Click on File > Open > File, browse to C:\ and select the
CreateLinkedServers.sql file.

If the following message is displayed, click Yes.
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n. Click Execute to run the script.

o. The BizInsight Content Installer only grants SQL sysadmin rights to the
user performing the installation. It is a good idea to add additional
administrative logins to ensure more users have sysadmin rights to this
SQL installation. The next steps describe how to add the built-in
Windows group "Domain Admins" with sysadmin rights as an example.
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p. Expand the Security node in the SQL Server Management Studio Object
Explorer. Right-click on Logins and choose New Login.

q. Click on Search.
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r. Click on Object Types and check the Groups checkbox. Click OK.
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s. Select your domain and click OK.

t. Type Domain Admins in the object name field, or the name of any
administrator user that should have sysadmin rights to the BizNet
SQL instance. Click OK.
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u. Select the Server Roles page and check the sysadmin checkbox.

v. Once completed, return to the Content Installer to continue with the
installation.

7. The Content Deployment dialog will open next. Most values will be
automatically completed for you in this dialog.

a.  IMPORTANT  If you will be installing content packs for multiple back
end systems (example, , change the Default Reporting Services
Folder Path to something generic like “” to ensure the content is
deployed to the same folder.  Do this for each content pack being
installed.  This is important because BizInsight can be pointed to
only one reporting services folder so all content must be deployed to
the same folder.
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b. Skip this step if you are using Sage 100 ProvideX.
Adjust the Server Name field if your accounting system database is
on another server.

c. Skip this step if you are using Sage 100 ProvideX.
Adjust the Database Name field to point to your accounting system
database.  If your accounting software uses a system or control
database, provide the name of that database rather than a company
database name.
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d. Skip this step if you are using Sage 100 ProvideX - data can only be
retrieved using Windows authentication.
Select the desired authentication method – Windows authentication
or Prompt for Credentials.

e. Click Deploy Content to continue.
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The Content Deployed Successfully dialog will open and display the
Web Service and the Report Manager URLs.  Click Close.

If you encounter an error deploying the DataSet Content, contact
BizNet Software Support for assistance.

8. The content installer will continue automatically installing elements.  You will
see the content installer window update with green checks as the installer
completes the elements.
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IMPORTANT

If the Deploy MetaData step fails with a message that the user does not have
sysadmin rights, see "Sysadmin Error Workaround" on page 144.

9. The License Administration Tool will open. Click on the browse button.

Browse to the directory that contains the BizInsight license file.
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10. Click the Validate License button to review the license information.  The
number of licenses purchased will be displayed.

11. Click on the Configure Users button to add your BizInsight users and assign
them to a BizInsight user type (Developer, Designer, Viewer or Drilldown). 
Click Commit Changes when finished.

 WARNING  Do not add your own login using the Admin Tool unless you know
for sure that you have another login available with sysadmin rights to the SQL
Server instance. Early versions of the content installer (pre version 1.6) will
remove existing permissions for users, including those with sysadmin rights. If
uncertain, skip this step and confirm sysadmin access will not be lost then
return to complete the Admin Tool step.
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IMPORTANT

To avoid errors when the License Administration Tool sets up security, be
sure to include the domain in front of the login ids.

12. You will be prompted to assign the necessary folder permissions and Reporting
Services security to the users.  Click Yes.
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For more information about the permissions that are set, see "Permission
Details" on page 201.

13. The Configuration Tool dialog will open. This dialog is already pre-populated
with appropriate default values.

Basic options to consider adjusting are listed below.

Tab Name Option Purpose

General Content Path Override If your user profiles are remapped to network
directories instead of to local hard drive
locations, use this option to specify a default
local directory to which the BizInsight Scan for
Content feature can copy the BizContent add-
in files.

Performance Query Timeout If your organization has a large chart of
accounts and many transactions each month,
it may be advisable to adjust this setting to a
higher value. The default is 3 1/2 minutes but
customers with significant data volumes may
benefit from a larger timeout setting when
drilling down to transaction detail.
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Tab Name Option Purpose

Security SQL Authentication
Prompt

If BizInsight users will be using SQL
authentication to retrieve data from the
accounting system database, change this
option to the Ask only once radio button to
ensure that users only have to provide their
credentials once for a given Excel session.

 IMPORTANT  Sage 100 ProvideX customers
cannot use SQL authentication.

Regardless of whether changes were made, click Configure now to produce an
app.config file that will be saved to the Configuration Path.

Click Exit to close the tool. For more information about this tool, see "Config
Tool" on page 204.

14. After automatic install is complete, relevant information about the installation
is displayed.  Click Close.

If you chose to use separate folders for the Admin and Config files, the dialog
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will look similar to the following:

15. The content installer will indicate that all elements have been successfully
installed.  Click Exit.
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Step 4: Assign rights in SQL Server Security

BizInsight users will need permissions to retrieve data from the accounting system
database or if the content pack is designed to retrieve data using a SQL linked server,
the users will need rights to the master database in SQL Server.

NOTE  If you are managing SQL Server security with an Active Directory group, just
add the new BizInsight user to that Active Directory group and go to the next step.

1. Click on Start >Programs > Microsoft SQL Server Version > SQL Server
Management Studio.

2. The Connect to Server dialog will open. Connect to the SQL Server instance
that hosts your accounting system database. Sage 100 ProvideX customers, this
will be the instance that contains the linked servers.
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3. In the left pane, expand Security. Look for your existing users to determine
whether they have been setup to use their Windows domain account or a SQL
Server account. You can tell one from the other by the presence of the
domain in front of the user name.

NOTE   If the user's login already exists in SQL Server, right-click their login id
and choose Properties. Then click here to jump to the User Mapping step.
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4. Right-click on Logins and click New Login.

5. In the Login – New dialog box, enter the user’s name in the Login name field.
If your existing users were setup with their Windows logins, click on Search to
browse for an existing Windows login id. If your existing users were setup with
a SQL account, type the new user’s login id and change the radio button to
SQL Server authentication.
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IMPORTANT  SQL authentication will not work for Sage 100 ProvideX
accounting systems. If you do not have an Active Directory domain, each user’s
login will need to be created as a local login on the Sage 100 ERP data server
with the same login id and password that the user uses on their client
workstation to mimic Windows authentication.
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6. Click on User Mapping in the left pane. Check the Map checkbox next to the
accounting system database.

If your content pack uses linked servers (Sage 100, QAD SE or EE, etc.), click
the checkbox next to the master database.
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7. Once the database is checked in the upper pane, check the db_datareader
role membership in the bottom pane. Click OK.

8. If the accounting system stores company data in separate databases, repeat the
steps of checking the database and the db_datareader role for each company
database.
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Step 5: Implement Column Based Security (Optional
feature)

The Security Tool for BizInsight is an application that activates or deactivates column
security and configures restriction for user access. When the column based security
mode is activated, all content modules installed on the server are impacted. See "
BizInsight Column Based Security Overview" on page 152 for more information about
Column Based Security.

System Requirements

Verify that your environment meets the following system requirements for Column
Security before proceeding:

l BizInsight 5.0.35.0 and later is installed on all client machines.

l Existing BizInsight and BizInsightDB databases created using a Content Installer
and were created directly in SQL Server (not converted using the Access to
SQL conversion tool).

l Reporting Services versions 2008, 2008 R2, 2012, 2014 or 2016

1. If you have not already downloaded the BizInsight Tools.zip., log into the
BizNet Software portal (http://biznet.flexnetoperations.com) and download
the file. You will find the tools with the BizInsight download file.

2. Extract the contents and open the Security Tool folder..
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3. Double-click the Security Application.exe to launch the Security Tool.

4. The Security Tool dialog will open.

5. In the Server field, type in the Server name and, if applicable, the instance
name for the SQL Server that hosts the SQL metadata databases (BizInsight and
BizInsightDB). The connection will be made using Windows Authentication by
default. Check the SQL Authentication checkbox to switch to SQL credentials
and supply those credentials in the Username and Password fields. Click
Connect.
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6. Click OK and the tool will create the tables needed for Column Security.

7. Click the Enable Security checkbox to turn on Column Security. This will
enable the Secure Column field.
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8. To enable security restrictions by domain\username, check the Apply domain
restriction in Username checkbox. This will cause the security tool to
evaluate the usernames entered and enforce a requirement that the user's
domain be present before their record can be committed.

9. Disregard the Security SQL field. This field contains a generic query to read
from the ColumnSecurity table. This field cannot be modified and is for
display only.

10. Type in the column name that will be used to restrict user access in the
Secure Column field. The Secure Column field contains a default value of
“CompanyCode”. Depending on the ERP system, the secure column value will
be different. In most circumstances, securing the company column is the ideal
method to restrict users from accessing confidential information. This column
name must exist in all RDLs across all content packs to be able to be used for
column restriction.
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11. Click Commit to write the Secure Column value to the database.

12. Click OK and the Security Tool dialog will update to display a section to add
user restriction values. Security is based on an "Exclusion Method". The IT
administrator must provide a restricted value to prevent user access. Users not
listed in this dialog will have access to all data.
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13. Use the Import File button to import a CSV file of usernames and Values or
manually type in the values to which the user should be denied access in the
Values field.
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Import CSV Manual Entry

An example CSV file is located in the
same folder as the Security Tool
executable.

Type in the user's Windows login id in the
Username field.

If the Apply domain restriction in
Username checkbox is checked be sure to
provide the domain name for the
Username field.

Type in the Values to which the user will
be denied access. Separate multiple
values with commas.
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14. When all usernames and values have been entered, click the Commit button.
The application will commit the changes to the ColumnSecurity table. Click
OK to the next two messages and the Dialog will update and display rows for
each username/value combination.

15. Use the Delete Row(s) button to remove any entries that are not wanted. Be
sure to highlight the entire row to be deleted.

16. Click Exit to close the tool.

17. Remove the two biz files (BizInsight.biz and BizInsightDB.biz) from the
Configuration Path directory. If you are not sure where the Configuration Path
is located, go to any BizInsight workstation. Start Excel and click on the
Application Settings button on the BizInsight ribbon.

For security to be fully implemented, each BizInsight workstation must be configured
to use SQL databases. This is covered in the section titled "Configure BizInsight" later
in this guide.
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Step 6: Add Registry Entries and Linked Servers

Skip this step if you used the Content Installer to automatically create the ODBC data
sources and Linked Servers.

1. Browse to the directory to which the files were saved. If you did not close the
Windows Explorer window that opened during the Content Installer process, it
should still be open.

2. Double-click the file named CreateODBCDataSources.reg.

3. Click Yes to confirm the addition of the information to the registry.
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4. Click OK at the Success message.

5. Double-click the file named CreateLinkedServers.sql. This file should
automatically open in SQL Management Studio.

6. Click the Execute button.
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7. The Messages window should open indicating that the script ran successfully.
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Step 7: Grant Rights to Service Account's Temp Dir-
ectory

Some BizContent RDLs require access to the temp directory of the SQL Server service
account to perform advanced manipulation of the data retrieved from Sage 100.
When these RDLs are executed by BizInsight users, SQL Server will impersonate the
BizInsight user’s Windows id when trying to access the temp directory. To avoid per-
missions issues, the BizInsight user accounts should be granted write access to the
SQL Server service account’s temp directory.

1. Click on Start > All Programs > Microsoft SQL Server version > Configuration
Tools > SQL Server Configuration Manager.
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2. Double-click the SQL Server service, usually SQL Server (BizNet), to open the
Properties dialog.

3. On the Log On tab, note the name of the account being used for the service.
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4. Browse to the temp directory for the service account and add the BizInsight
users to this directory giving them Modify permissions.

 IMPORTANT  Be sure to change the permissions only for the folder named
“temp” and not higher level folders.

NOTE  It may be necessary to change Windows Explorer’s Folder Options to
Show hidden files and folders as the temp directory is usually located in the
account’s profile directory.

Windows Server 2003:
Temp directories are located in C:\Documents and Settings\profile name\Local
Settings.
How to show hidden files and folders:
http://www.microsoft.com/resources/documentation/windows/xp/all/proddo
cs/en-us/win_fcab_show_file_extensions.mspx?mfr=true

Windows Server 2008 and higher:
User temp directories are usually located in C:\Users\profile name\App
Data\Local.
Built-in service account temp directories are located in located in
C:\Windows\ServiceProfiles.
How to show hidden files and folders: http://windows.microsoft.com/en-
US/windows7/Show-hidden-files

http://www.microsoft.com/resources/documentation/windows/xp/all/proddocs/en-us/win_fcab_show_file_extensions.mspx?mfr=true
http://www.microsoft.com/resources/documentation/windows/xp/all/proddocs/en-us/win_fcab_show_file_extensions.mspx?mfr=true
http://windows.microsoft.com/en-US/windows7/Show-hidden-files
http://windows.microsoft.com/en-US/windows7/Show-hidden-files
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Step 8: CheckTCP/IP, SQL Browser and Firewall Excep-
tions

The XMLFast feature added in an earlier BizInsight build requires the following server
configuration changes:

l The TCP/IP protocol must be enabled for SQL Server and the SQL Browser Service
must be running. see "Enable TCP/IP" below.

l Server firewall exceptions must be added for TCP Port 1433, UDP Port 1434 and a
program exception for sqlservr.exe. see "Add Windows Firewall Exceptions" on
page 66

Customers are strongly encouraged to make these changes in order for the XMLFast
feature to work. While the XMLFast feature can be turned off on the client work-
station in Application Settings, doing so will result in significantly slower data
retrieval times.

Enable TCP/IP

1. Click on Start > All Programs > Microsoft SQL Server 2008 (2008 R2) >
Configuration Tools > SQL Server Configuration Manager.
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2. Expand SQL Server Network Configuration and select the Protocols for
InstanceName that corresponds to the SQL Server instance that hosts the
accounting system database.

3. Verify that the TCP/IP Protocol is "Enabled".  If it is not enabled, double-click
on the protocol and change its properties to enabled.  You will receive a
warning that the service will need to be stopped and restarted:
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4. Go to the SQL Server Services section.  Select the SQL Server service and
click on the restart the service button.

5. In the SQL Server Services section, verify that the SQL Server Browser service
is started.  If it is not, double-click on the service to open the service
properties.
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6. Click on the Service tab and make sure the Start Mode is set to "Automatic".
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7. On the Log On tab, click on the Start button to start the service
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Add Windows Firewall Exceptions

This step may not need to be performed if the Windows Firewall is turned off on the
server.

Server 2003 (click here to go to the Server 2008 instructions)

1. Click on Start > Control Panel > Windows Firewall
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2. On the Exceptions tab, click the Add Port button.
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3. In the Add a Port dialog, enter a name for the exception entry and type "1433"
for the port number.  Click OK.

4. Add a second port exception for UDP 1434.
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5. Click the Add Program button then click the Browse button

6. Browse to the SQL Server installation’s Binn directory and select sqlservr.exe.
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7. Close the Firewall dialog after making these additions.

Server 2008

1. Click on Start > Administrative Tools > Windows Firewall with Advanced
Security
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2. Click on Inbound Rules.

3. Click on New Rule.
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4. Choose the Port radio button and click Next.
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5. Leave the TCP option selected and type in port 1433.  Click Next.
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6. Leave the Allow the connection radio button selected and click Next.



BizInsight 5.0.35.2 Installation Guide: Installation Activities for the Server

BizNet Software, Inc 75| Page

7. Uncheck the Public checkbox (unless users are connecting using a public
network location) and click Next.

8. Type a name and description for the exception and click Finish.



BizInsight 5.0.35.2 Installation Guide: Installation Activities for the Server

BizNet Software, Inc 76| Page

9. Repeat these steps to add a UDP port exception for port 1434.
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10. Add a third new inbound rule for a program exception.
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11. Click on the Browse button and browse to the SQL Server installation’s Binn
directory and select sqlservr.exe.  Then click Next.
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12. Leave Allow the connection selected and click Next.
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13. Uncheck the Public checkbox (unless users are connecting using a public
network) and click Next.

14. Type a name and description for the exception and click Finish.



BizInsight 5.0.35.2 Installation Guide: Installation Activities for the Server

BizNet Software, Inc 82| Page

Step 9: Run Content Installer for Additional Content
Pack(s)

1. The Welcome dialog will open.  Click Next.

2. Review the End User License Agreement and if you agree to the terms, check
the I accept the terms in the License Agreement checkbox and click Next.
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3. Click on the desired Setup Type button.

Custom setup type options that are available:
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4. Click Install.

5. Click Yes to any User Account Control messages.

6. When the installer completes, an icon will exist on the desktop if you did not
disable the creation of shortcuts.

7. Double-click the shortcut on the desktop to launch the content installer.  If
you chose a Custom installation and disabled the creation of shortcuts, you
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must browse to the directory to which the content installer files were
extracted and double-click the BizNet Content Installer.exe. If you installed to
the default directory location, that directory can be found in C:\Program Files
(x86)\BizNet Software.

8. The content installer will inspect the server and determine what elements
already exist and indicate their presence with a green check mark.

Sage 100 ProvideX customers will see the following:
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9. Click on the Relevant Information link in the upper right corner and make a
note of the Report Folder name:

Note  If the Relevant Information dialog does not contain any information and
BizInsight is already installed, go to a workstation where BizInsight is installed.
Open Excel on the workstation, click on the Application Settings button on
the BizInsight ribbon and copy the values provided for the Configuration Path,
the Administration Path, the Default Reporting Services Server and the
Default Reporting Services Folder Name fields.

10. Click Automatic Install.
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11. The content installer will deploy the MetaData and function content.  The path
will be automatically defaulted to the path last used.  Click OK.

12. The content installer will open the content deployment dialog.  Most paths
will not need to be changed.  But you must check the following to make sure
they are correct:

a. Make sure the folder name is the folder name currently being used. If
the folder is not the same as shown in the Relevant Information dialog,
change that field to match the folder that is currently being used.

b. Sage 100 ProvideX customers, skip this step.
Adjust the Server Name field if your accounting system database is on
another server. NOTE  The server name will default to the last server
used. This may not be the right server for the content pack being
deployed.
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c. Sage 100 ProvideX customers, skip this step.
Adjust the Database Name field to point to your accounting system
database. If your accounting software uses a system or control database,
provide the name of that database rather than a company database
name. NOTE  The database name will default to the last database used.
This may not be the right database for the content pack being deployed.

13. Sage 100 ProvideX customers, skip this step - you must use Windows
authentication.
Select the desired authentication method – Windows authentication or Prompt
for Credentials. 

 IMPORTANT  You must use the same authentication method as selected for
other content packs.

14. Click Deploy Content.

15. The content installer will display a status message to indicate that it is
working.
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16. Once complete, the installer will display links to the Reporting Services sites. 
Click OK to continue with the installation.

17. The License Administration Tool will open.  Unless you need to add new
users, click Exit.

18. The content installer window will display the results of the automatic install. 
Click Close.
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19. Click Exit to close the content installer.

20. Repeat the above steps for each content pack that needs to be installed.
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Step 1: Install Oracle Data Access Components (ODAC)

If your accounting system is using an Oracle database, you must install the Oracle
ODBC driver and ODP.Net on each client workstation in order for BizInsight to be
able to retrieve data from the Oracle database. If your accounting system does not
use an Oracle database, this step can be skipped.

IMPORTANT

When installing the Oracle Client, it is insufficient to install the Runtime Engine as
that does not install the Oracle ODBC driver.
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Step 2: Install BizInsight

 IMPORTANT  If you are implementing BizInsight in a Terminal Services/Citrix envir-
onment, stop here and switch to the document titled "Citrix Terminal Services Install-
ation Guide" for alternate setup steps for that type of implementation.

1. Locate the BizInsight product installation files that you downloaded
from the portal site and extract the contents.

2. Extract the .zip contents to any directory that is accessible from the
client workstation.

3. Double-click the Setup.exe.

NOTE As of the 5.0.35.2 release, there is a single Setup.exe for all
supported Office versions.

4. The installation will check to see if Microsoft .Net Framework 4.0 is
installed.  If not installed, the following dialog will display.  Click
Accept.
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5. The installation will then check to see if the Microsoft Office Primary
Interop assemblies for the installed Excel version are installed as well as
a specific Microsoft Update that is necessary for proper Excel add-in
functionality.  If not found, the following dialog will display.  Click
Install.
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6. The splash dialog will open.  Click Next to continue.
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7. The Welcome dialog will open.  Click Next to continue.

8. The License Agreement dialog will open.  Read through the agreement
and if you agree with the terms, click the I agree radio button and then
click Next.
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9. Accept the default installation directory or browse to a location of your
choice. Click Next.

10. Click Next at the Confirm Installation dialog.
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11. When installing BizInsight versions 5.0.35.1 or higher, the Enter your
Configuration Path dialog will open. If you have an app.config file
produced by a Content Installer in your Configuration Path, leave the
default option. Click OK.

If you do not have a Content Installer created app.config file, choose
the User Managed radio button to proceed. You will need to supply the
key paths when configuring BizInsight for the user. When you click OK,
the Import Settings Skipped dialog will open. Click OK.
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12. If the Centrally Managed option was selected, click the Browse button
and browse to the Configuration Path shared directory.

Click Import Settings.

13. Once the installation completes, click Close.
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Installing BizInsight for the Non-Administrative
User
If you have installed BizInsight while logged in as a different login than the BizInsight
end user, you will need to perform the following additional steps in order to get
BizInsight functioning for this user.

1. After completing all of the preceding steps to install BizInsight, log out of the
client workstation and log back in as the BizInsight user.

2. Open Windows Explorer and browse to the reg5 subdirectory of the BizInsight
local directory.

3. Double-click the file named "Register BizInsight for Excel xxxx
OnDemand.bat", where “xxxx” is the Excel version (2003, 2007, 2010 or 2013).

4. If the workstation is running Windows 7 with User Account Control (“UAC”)
enabled, click Yes to all UAC pop-ups.  Click Yes or OK to all dialogs that open.

 IMPORTANT  If you get the following error when running the .bat file, you
must edit the file named “Register BizInsight for Excel xxxx OnDemand.bat” to
add the file directory path to each regedit.exe line.
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To edit the "Register BizInsight for Excel xxxx OnDemand.bat", open it with
Notepad and add the file directory path to each regedit.exe entry in the file.
For example:

5. When the .bat file completes, start Excel and continue with the next steps.
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Step 3: Configure BizInsight

1. If you used the Content Installer to create an app.config file to use for
Centrally Managed settings, you can skip this step.
You will need to know the paths for the BizInsight implementation. Go to the
server and start the Content Installer. Click on the Relevant Information link
and make a note of the values shown.

2. While logged in as the BizInsight end user, open Excel.

The next steps depend on whether you chose the Centrally Managed option at
the end of the BizInsight installation or chose to manage your settings at the
user level. Click here to jump to the Centrally Managed steps.

If you installed an older BizInsight version that prompted for these paths
during installation, follow the User Managed Settings Steps.

User Managed Settings Steps (blue background)
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3. If you receive the following dialog, click Skip.

Click OK to the next message regarding the use of default settings.

If you receive the following error, go back to the server and grant the user
BizInsight security rights, see "Assign BizInsight Security to Users" on page 157.
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4. The Application Settings dialog will open. If it does not open, click on the
Application Settings button on the BizInsight ribbon.

Perform the following steps:
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a. Provide Essential Paths
You must provide values for the Configuration Path, the Administration
Path, the Default Reporting Services Server and the Default Reporting
Services Folder Name fields.

You should have looked up these values at the start of this section.
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b. SQL Credentials Steps (skip if not using SQL credentials for data
retrieval from the Accounting database)

If you configured the Reporting Services data source to use SQL
credentials during content deployment, check the Persist SQL
Authentication checkbox.

c. Click on the Local Content button. If the default path displayed is not a
local directory, click on the Override checkbox and change the path to
a directory that resides on the local computer, C:\BizInsight is
suggested.
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d. SQL MetaData Databases and Column Security Steps

If the BizInsight SQL metadata databases (BizInsight and BizInsightDB)
were implemented during the server setup, click on the Configure
SQL button. If the Application Settings dialog does not have this button,
BizInsight is not the right version. You need to uninstall and install the
most current BizInsight version.

 IMPORTANT  This step is essential to complete Column Based security
configuration. See " BizInsight Column Based Security Overview" on page
152 for more information about this optional security feature.
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i. Check the Use SQL Server for MetaData checkbox and enter the
SQL Server name, and instance name if applicable, where the
BizInsight SQL databases (BizInsight and BizInsightDB) are located.
The format should be servername\instancename.

ii. If users will be connecting to the SQL metadata databases using
SQL authentication, check the Use SQL Authentication checkbox.
You will get the following Warning message indicating that the
credentials provided will be stored in clear text in a
configuration file in the user’s profile.
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Click OK and enter a valid SQL login and password with
appropriate rights to the SQL MetaData databases. Click OK. 

 IMPORTANT This dialog allows you to use a different method of
connectivity to the BizInsight MetaData databases than for the
accounting system database.

e. Close the Application Settings dialog.

5. Re-start Excel. 

6. Click on the BizInsight tab and then click on the BizInsight Explorer button to
load the Navigation Pane.

7. Skip to the next white background step.

Centrally Managed User Settings (green background)
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8. If you are using Centrally Managed settings, you will see Scan for Content run
when you first open Excel. Click OK and restart Excel.

9. You should see the Navigation Pane display on the left side in Excel.

10. If you receive the following error, go back to your server and make sure all of
the configuration changes have been made for XMLFast (see "CheckTCP/IP, SQL
Browser and Firewall Exceptions" on page 60) and make sure the end user has
the db_datareader and db_datawriter permissions to the SQL metadata
databases ( BizInsight and BizInsightDB).

Click OK to this message as well as the one that follows:
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If you receive the following error, go back to the server and grant the user
BizInsight security rights, see "Assign BizInsight Security to Users" on page 157.

You are now ready to test the installation. Proceed to "Verify the BizInsight
Installation".
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Step 4: Verify the BizInsight Installation

You must create or refresh an existing report to verify the BizInsight installation. If
the user just installed is a Viewer or Drilldown user, you must verify the installation
by refreshing a report that has already been created by a Designer user. Locate an
existing report, open it in Excel and right-click on a cell and choose BizNet Refresh.
If it refreshes without error, the installation is complete.

If an existing report does not exist, the following steps can be used to create a
simple report with which to verify the installation.

Note  Your login id must be setup as a Designer user to be able to perform these
steps; you may need to temporarily add your login as a Designer user using the Admin
Tool to perform these steps. The Admin Tool can be accessed from the Content
Installer interface on the server.

 WARNING  Do not add your own login using the Admin Tool unless you know for sure
that you have another login available with sysadmin rights to the SQL Server
instance. Early versions of the content installer (pre version 1.6) will remove existing
permissions for users, including those with sysadmin rights. If uncertain, skip this step
and confirm sysadmin access will not be lost then return to complete the Admin Tool
step.

1. In separate cells in your Excel worksheet, type in a valid Company Code, Fiscal
Year and Period.
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2. In the Navigation Pane, expand YourContentPackName > Functions > Month to
Date. Click on a Net function and drag it into a cell in the Excel worksheet.

If the Function Arguments dialog does not automatically open, click on the
Excel Insert Function button (fx)



BizInsight 5.0.35.2 Installation Guide: Installation Activities for Client Workstation(s)

BizNet Software, Inc 114| Page

3. Click on the cells containing your input parameters and then click OK
.

4. If the function returns data or a zero, your installation and configuration are
correct.

Once the installation is confirmed, save this report to a shared directory to use for
verifying the installations of Viewer and Drilldown users. These users cannot add func-
tions to reports so you will need an existing report that you can refresh to confirm
there are no errors. To verify the installations for Viewer and Drilldown users, install
and configure , open this report, right-click and choose Refresh.
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Step 5: Install BizInsight Desktop Edition

If you are implementing a System Connector release, the BizInsight Desktop Edition
product must also be downloaded and installed on the client workstation.

1. Download the BizInsight Desktop Edition product from the customer portal
site, http://biznet.flexnetoperations.com.

2. Extract the contents and double-click the setup.exe

3. The installer will prompt to download the BizNet API. Click Install.

IMPORTANT

If the .msi is run before running the setup.exe, the following error will
occur:

http://biznet.flexnetoperations.com/
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4. If a User Account Control dialog opens, click Yes.

5. The End User License Agreement dialog will open. Review the license terms
and if you agree with the terms, select the I agree radio button and click
Install.
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6. Click Finish when the installation completes.
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Adjusting the Sage 100 ODBC paths

The Content Installer retrieves the paths to the Sage 100 company data directories
from the SOTAMAS90 ODBC data source. If the paths in that data source are UNC or
mapped drive paths, they must be changed in order for BizInsight to be able to
retrieve data from the Sage 100 companies.

1. Click on Start > Control Panel to open the Control Panel. Double-click on
Administrative Tools.

 IMPORTANT  For Sage 100 implementations that are using the 32-bit ODBC
driver on 64-bit hardware, the 32-bit ODBC manager must be run from the
%systemdrive%\Windows\SysWoW64 directory. Double-click the Odbcad32.exe
and continue to the next step.
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2. Double-click Data Sources (ODBC).

3. On the User DSN tab, select the SOTAMAS90 data source and click Configure.

If you get the following error, you are in the 64-bit ODBC administrator and
the ODBC driver is 32-bit and must be managed using the 32-bit ODBC
administrator tool. Refer to the note earlier in this section for information on
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where to find the 32-bit ODBC administrator tool.

4. Change the Database Directory field from the UNC path (or mapped drive
path) to the local directory location of the Sage 100 data.

5. On the Options tab, change the paths to the Sage 100 ERP system files to local
directories.

Prefix for data files: [Sage100 database directory path]\SY\;[Sage 100
database directory path]\==\

Path to Views DLL: [Sage 100 database directory path]\Home
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6. Click OK to save these settings.

7. Restart the Content Installer and restart the automatic installation.
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Manually Deploying Content Reporting Services Reports

If the content installer does not detect your existing reporting services installation, it
may be necessary to manually deploy the reporting services reports. 

1. Run the content installer setup.exe to lay down the content files.

2. On the server where Reporting Services is installed (you’ll have to make
sure that it is installed and configured), open SQL Server Business
Intelligence Development Studio.

or Microsoft SQL Server 2012 > SQL Server Data Tools

Note  The SQL Server Data Tools for BI ("SSDT BI") is a separate download for
SQL Server 2014.
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 IMPORTANT  If your server operating system is Windows Server 2008 or
higher and User Account Control is enabled, Ctrl+Shift+Right-click on SQL
Server Business Intelligence Development Studio (or SQL Server Data Tools)
and choose “Run as administrator”.

3. Click on File > Open > Project/Solution
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4. Browse to the directory to which the content was installed, locate the
Reporting Services folder and select the .sln file. If one does not exist,
select the .rptproj file.

5. Right-click on the shared data source and choose Open.
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6. Click on Edit.

7. Enter the accounting system database server name (and instance name if
applicable) in the Server name field.  Select the accounting system
database from the database drop down list. If your accounting system uses a
system or control database, select that database instead of a specific
company database.  Once configured, click OK.
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8. In the Solution Explorer, right-click on the top level and choose
Properties.

9. Fill in the TargetReportFolder field with your preferred default folder
name and complete the Target Server URL field with the reporting
services web service url.  Click OK.
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10. Right-click on the top level in the Solution Explorer and choose Deploy.

11. Once the RDLs are deployed, double-click on the content installer icon on
the desktop.

12. Run the Deploy MetaDataContent and Deploy Function Content options in
the Manual Install Steps section to complete the content pack installation.
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Manually Installing BizContent Add-ins

If you are using a BizInsight version that is older than , you will need to register the
BizContent add-ins manually in Excel. BizNet Software recommends upgrading to the
latest BizInsight version but if that is not possible, perform the following steps:

1. Browse to the BizInsight shared directory and copy the content add-in files
(.dll, .xll and .dna) to the directory to which you installed the BizInsight
client.  If you are using separate config and admin folders, the client add-in
files will be in the config folder.

The remaining steps vary based on the Office version installed:

Office 2010/2013 steps
Excel 2007 steps
Excel 2003 steps

Excel 2010/2013

1. Click on File > Options.
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7. Click on Add-ins in the left pane and then click on Go at the bottom on
the right pane.
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2. In the Add-ins dialog, click on the Browse button.

3. Browse to the directory to which you installed BizInsight and select the
.xll file in that directory.  Then click OK.

The Add-ins dialog should now look like the following:
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4. Click OK.
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Excel 2007

1. Click on the Office button and then click on the Excel Options button.
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2. Click on Add-ins in the left pane and then click on Go at the bottom on
the right pane.



BizInsight 5.0.35.2 Installation Guide: Appendices

BizNet Software, Inc 136| Page

3. In the Add-ins dialog, click on the Browse button.

4. Browse to the directory to which you installed BizInsight and select the
.xll file in that directory.  Then click OK.

The Add-ins dialog should now look like the following:
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5. Click OK.
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Excel 2003

1. Click on Tools > Add-Ins
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2. In the Add-ins dialog, click on the Browse button.

3. Browse to the directory to which you installed BizInsight and select the
.xll file in that directory.  Then click OK.

The Add-ins dialog should now look like the following:
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4. Click OK.
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Converting V4 Reports to BizInsight 5.0

This version allows V4 customers to run their existing reports in 5.0 without the need
to re-write their reports immediately.  Customers are strongly urged to re-write their
reports in order to be able to drill down on functions and take advantage of any new
5.0 capabilities not available with V4 functions.  In addition, V4 customers who move
to V5 will not benefit from the performance improvements made to the product
unless V4 functions are converted to V5 functions.

Customers upgrading to a 5.0 version of BizInsight from V4 will have to search for
“BizAddIn.ExcelAddinModule1.” and replace with nothing for their reports to run in
the newer BizInsight version. The user’s BizFunctions.xml must be copied to the con-
tent share directory that contains the 5.0 content client files (.dll, .dna, .xll).  When
searching your workbook, be sure to change the scope of your search from “Sheet” to
“Workbook” to find all occurrences.
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OptimizeCache Adjustments

Most content packs come with special BizProperty settings named OptimizeCache.
These properties establish what column to index for each in memory data cache and
are essential for optimal report refresh times.  We strive to design our content packs
for the majority of customers.  Given the flexibility provided by many accounting sys-
tems regarding account mask design, the differences in accounting system usage from
customer to customer as well as individual report design differences, the default con-
figuration may not be optimal for all customers and thus may need to be tuned for
your specific use of your accounting system.  As an example, we might optimize on
Segment1 with the expectation that the natural account is in Segment1.  Customers
for whom their natural is not in Segment1 will need to adjust their OptimizeCache
properties for the appropriate location of their natural account in their account
masks.

Use the User-Defined Properties analysis set on the Properties menu to list any
OptimizeCache properties that may exist for your implementation. For information
on how to access the User-Defined Properties analysis set, see the section titled "Nav-
igation Pane" in the User Guide.

If you feel you need to tune your BizInsight implementation, please refer to the doc-
ument titled "Report Performance Guide" for instructions on how to optimize your
in-memory caches.
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Sysadmin Error Workaround

In some environments, the BizContent installer fails on the Deploy MetaData step
with an error that the user does not have sysadmin rights. The following steps can be
taken to workaround this issue. Before proceeding with these steps, be sure to check
that the Windows account you're logged onto the server with does have sysadmin
rights in SQL Server security. An account can be a domain admin or local admin-
istrator and not have sysadmin rights in SQL Server.

1. Open SQL Server Management Studio. Click on File > Open > File and browse
to the scripts subdirectory of the Access To SQL Conversion Tool folder. Select
the first script and click Open.

Execute the script to create the BizInsight database.
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If the following error occurs, the login you are logged in with does not has
sufficient rights to create the databases. Disconnect and log back in as a user
with sysadmin rights.

If an error occurs that an exclusive lock could not be obtained for the model
database, you will need to stop and restart the SQL Server service.
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Close the script and repeat steps 2 and 3 for the second script which will
create the BizInsightDB database. Once both scripts are executed, you will see
the two new databases added to the Databases section:
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2. Open the Access to SQL directory and double-click the AccessToSQL.exe.

The application will prompt to install .NET 4 if not found on the local
machine.

3. Locate the biz files to convert. Press the search button and browse to the
content installer's installation folder. The default location of the .biz files
should be C:\Program Files (x86)\BizNet Software\ContentName and
version\Content\Server\Shared Directory.



BizInsight 5.0.35.2 Installation Guide: Appendices

BizNet Software, Inc 148| Page

You will receive the following error if you select a folder that does not
contain the Access-based .biz files:

4. In the Machine name field, type in the sever name and instance name, if
applicable, of the SQL Server installation where you want the SQL metadata
databases created. Ex: servername\instancename.
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If the server is not found, the following error will display:

5. Click the Check button to enable the Convert Files button.
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6. Click the Convert Files button to start the conversion process.

6. Once the conversion is complete, a log will be displayed.

NOTE  The RestrictedFunctions table count may be different from the original
count. The process removes duplicate function names.

7. Click Close to close the log display. Then click Cancel to close the Access to
SQL Tool.
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8. Go back to the Content Installer and re-run the Deploy MetaData step. It
should run without error.

9. Complete any remaining Content Installer steps. Be sure to run the Admin Tool
step to ensure users are given rights to the SQL MetaData databases.
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BizInsight Column Based Security Overview

Disclaimer:

The following information is for general purposes only. The information is
provided by BizNet Software and while we strive to keep the information up to
date and accurate, we make no representations or warranties of any kind, express
or implied, about the accuracy or reliability with respect to our internal research
contained in this documentation. Any reliance you place on such information is
therefore strictly at your own risk.

In no event will BizNet Software, Inc or BizNet Software, Inc. be liable for any loss
or damage including without limitation, indirect or consequential loss or damage,
or any loss or damage whatsoever arising from loss of data or profits arising out
of, or in connection with, the use of the documentation.

In any ERP system, the balance between making data accessible to end users while
denying access to those who should not have access is a difficult challenge. ERP
security only at the application layer is not a truly secured system; the com-
munication between the application and the data is exposed to users who are not
authorized to access confidential information. BizNet Software has incorporated four
layers of security into the BizInsight product. These security levels are as follows:

1. BizInsight License User Types Security

2. DataSet Security – applies to RDL security on the Report Server.

3. MetaData Security – applies to SQL Database and Shared Directory folder.

4. Column Security – applies to all functionality on content packs. (Functions,
Drill-downs, and Analysis Sets)

Of the above four security levels, two are specifically provided with the BizInsight
product: BizInsight License User Types Security and Column Security. The other two
items, DataSet Security and MetaData security, utilize the native security model
provided with Reporting Services, SQL Server,and Windows NTFS security.

BizInsight uses Reporting Services to store the queries and datasets used for con-
nectivity to the accounting system. Reporting Services provides its own security and
BizInsight objects can be independently secured using the delivered Reporting Ser-
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vices security model. Users must be granted access to the BizInsight objects published
to Reporting Services in order to utilize them.

BizInsight uses SQL databases (BizInsight and BizInsightDB) to store product metadata.
BizInsight users must be provided access to these databases using native SQL Server
security. In addition, the BizInsight shared directory is also a metadata repository and
sufficient Windows NTFS security.

BizInsight License User Types Security

This security level ensures that only licensed users are able to use the BizInsight
product. In addition, BizInsight licensing is broken out into different user types: .
The different user types have decreasing capabilities with the Designer user having
the most capabilities. See the User Guide for more information regarding the dif-
ferent user types and their capabilities.

Column Security

Column security is based on a security policy that specifies the rules and conditions
under which a user can access a column value from a table. The column access restric-
tion is based on individual user permissions. When defining the column to apply the
restriction, the column must exist across all datasets from which BizInsight is retriev-
ing data. In most business policies, restricting access by the “Company" column is the
most frequently used security logic; however, BizInsight provides the flexibility to
utilize other columns.

The column security design uses an optimistic method in restricting user access: IT
administrators will need to provide the values to deny. Values not listed are inferred
to be allowed. For example, if a user is permitted to access 97 out of 100 unique val-
ues, 3 restricted values will need to be defined when defining column security for
that user. The remaining 97 values not defined in the security table will be able to
be accessed by that user. All possible threats, vulnerabilities, and attacks and choos-
ing the security design to implement are based on threat mitigation as first and per-
formance second.

When column security is enabled and user restrictions are defined, access to the data
will be restricted for the particular user. On the client machine, the user restriction
policy applies to all content modules and functionality. Any access to functions, drill-
down, and analysis set is denied if the restricted value is inserted in the feature. In
the scenario of multiple parameters being passed to a function, if one of the para-
meter values is restricted, the security will deny access completely even though the
user many have access to the non-restricted values.
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Security vs Performance

Design choices for securing a system affect performance, scalability and usability.
The more secure a system becomes, the more companies must compromise in terms
of performance and usability. In selecting the best balance between security and per-
formance, the optimistic security design has proven to be the ideal option. The
below research and development results are based on BizNet Software internal test-
ing and illustrate the impact security has on performance. Results will vary depend-
ing on network connection, environmental setup, and Microsoft Office bitness.

Scenario:
Excel 2010 64-bit
BizData Iterations - 80,688
Dedicated Server and Client Machine

First
Refresh
(sec)

Second
Refresh (sec)

Offline
Mode

Number of
Restricted

Values

Baseline: Security OFF on SQL Database 114.57 113.18 69.07 N/A

Security ON with no restricted users 111.4 109.38 75.18 0

Security ON and restricted values apply to
the current user

118.81 114.61 74.16 1

Security ON and restricted values apply to
the current user

124.54 119.9 80.14 6*

Security ON and restricted values apply to
the current user

132.14 126.58 86.39 12*

Security ON and restricted values apply to
other users

114.97 120.16 69.28 N/A

Security ON and restricted values apply to
all users

124.64 119.29 79.16 N/A

* Multiple restricted columns is not currently supported

Key Results:

1. When Security mode is activated with no restricted values in the security
table, little to no significant reporting performance loss.

2. When Security mode is activated with restricted values in the security table,
there is about a 10% loss in reporting performance.
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3. When Security mode is activated with double the amount of restricted values
in the security table, there is about a double percentage loss in reporting
performance.

Column Security Limitations

l Only a single column can be restricted. Multiple column security is not supported.

l The column must exist across all content packs.

l The column must exist as a server side parameter on RDLs. Security on optional
parameters is not supported.

l The column name should be uniform across all RDLs.

l Connected to an single ERP. Multiple ERP systems are not supported.

l Security is based on an ‘Exclusion Method’. IT administrators must insert values to
restrict access.

Requirements to Use Column Security

l BizInsight 5.0.35.0 and later is installed on all client machines.

l Existing BizInsight and BizInsightDB databases created using a Content Installer
and were created directly in SQL Server (not converted using the Access to
SQL conversion tool).

l Reporting Services versions 2008, 2008 R2, 2012, 2014 or 2016

Column Security User Experience

When a user tries to access data to which they have been denied access, the cell will
display #VALUE.
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To confirm that the error is due to Column Security, check the event log by clicking
on the About button on the BizInsight ribbon and then clicking on Support Tools >
View Events. A #COLUMN_SECURITY error will be logged there if the #VALUE is due to
restricted access.

If the user refreshes a report that tries to retrieve data for a company to which they
have no access, an error message will be displayed indicating they have requested
restricted data:

Analysis sets that try to retrieve restricted data will return #COLUMN_SECURITY:

Refer to the Installation Guide for instructions on implementing Column Based Secur-
ity.
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Assign BizInsight Security to Users

Each BizInsight user’s Windows account name must be added to a .users file in the
admin shared directory in order for that user to perform any BizInsight action. You
will use the License Administration Tool to perform these steps.

To assign BizInsight security to your users, do the following:

1. On the server, double-click any content installer desktop icon. If the content
installers were installed without desktop icons, browse to the installation
directory and double-click the file named "BizNet Content Installer.exe". If the
content installer was uninstalled, reinstall it.

If you do not want to reinstall the content installer, see "Manual Steps" on
page 163.
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2. Click on the Admin Tool button.

3. Click on the ellipses and browse to the admin share folder of your BizInsight
shared directory.
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4. Select your BizInsight license file and click Open.

5. Click on the Validate License button to check how many licenses you
currently have. Your current license count will be displayed.
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6. Click on the Configure Users button. The Current Users dialog will open.

7. You will now add your new BizInsight user and assign them a user type. Click
on the User Type drop down and select the desired user type. If you want
your user to be a Designer, choose Designer from the drop down list.
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8. Type the user's name in the Users field in the format of domain\username.

 WARNING  Do not add your own login using the Admin Tool unless you know
for sure that you have another login available with sysadmin rights to the SQL
Server instance. Early versions of the content installer (pre version 1.6) will
remove existing permissions for users, including those with sysadmin rights. If
uncertain, skip this step and confirm sysadmin access will not be lost then
return to complete the Admin Tool step.

9. Click on the Commit Changes button when finished. You will be presented
with a message asking if you want to grant the user additional security
permissions. Click Yes.

If you have entered more names for a particular user type than you have
licenses, you will get an error similar to the following.



BizInsight 5.0.35.2 Installation Guide: Appendices

BizNet Software, Inc 162| Page

You will be returned to the Current Users dialog where you can remove a row
so that you comply with the number of licenses your company purchased.
Select the row to remove and click the Delete Row button.

To purchase additional licenses, use the BizNet Assistant button to open a
support ticket indicating that you need to purchase additional licenses.

When you receive your new license, move your old license from the
Administration Path shared directory and save the new license there. Do not
rename the old license and leave it in the Administration Path; it must be
removed from the directory in order for the new license count to take effect.
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Manual Steps

1. In the Admin shared directory, open the .users file with Notepad that
corresponds with the BizInsight permissions the user should have. For example,
if the user should have Designer permissions, you would open the
Designer.users file.

Tip  If you are not sure where to find the Admin shared directory, go to an
existing user’s workstation, open Excel and click on the Application Settings
button on the BizInsight ribbon and copy the path provided for the
Administration Path.

2. In the .users file, add the Windows account name of the BizInsight user. For
more information on the different user types, refer to the User Types section
of the User Guide.

3. Save and close the file.

 IMPORTANT  As you add Windows account names to the .users files, add only
as many as you have licenses. If you add more Windows account names than
you have licenses or you have an extra line return in the file, users will get an
error message similar to the following when they open Excel after BizInsight is
installed.
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If you are not sure how many licenses you have, open the .lic file that is in the
Admin shared directory with Notepad and check how many licenses are shown
for the user type you are adding.

To purchase additional licenses, use the BizNet Assistant button to open a
support ticket indicating that you need to purchase additional licenses.

When you receive your new license, move your old license from the
Administration Path shared directory and save the new license there. Do not
rename the old license and leave it in the Administration Path; it must be
removed from the directory in order for the new license count to take effect.
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Content Installer Manual Install Steps

Use the Manual Install Stages section to implement each element yourself.  You may
choose to use this approach when only certain elements need to be implemented or
the automatic install is not detecting your existing Reporting Services installation.

Install Report Server 167

Create Report Server User 172

Create Linked Servers 173

Run Database Scripts 188

Deploy Data Set Content 190

Deploy MetaData Content 193

Deploy Function Content 197

Administration Tool 198
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Relevant Information 211
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Install Report Server
Use the Install Report Server button to either install SQL Server and Reporting Ser-
vices or point the content installer to an existing SQL Server instance. The Content
Installer will detect previous installed instances of SQL Server 2008, 2008 R2, 2012, or
2014 on the local server machine.

If no instances of SQL Server are detected, the Content Installer will install 32-bit
Microsoft SQL Server 2008 R2 Express with Advanced Services.  IMPORTANT  If your
existing SQL Server installation is not detected and you do not want to install SQL
Server 2008 R2, cancel the installation, restart the Content Installer and see "Deploy
Data Set Content" on page 190.

1. Click on the Install Report Server button to start the process.

2. You may be asked to enable the local Administrator account. Click OK,
Thanks, even if you know that the Administrator account is enabled.
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3. The installer will ask whether you are using a 32-bit version of Sage 100 or a
64-bit version. Choose the appropriate button.

 IMPORTANT  This question controls whether a 32-bit a 64-bit version of SQL
Server is installed. SQL Server can only access and use ODBC drivers that are
the same bitness. If you do not know whether your Sage 100 installation is
using a 32-bit or 64-bit ODBC driver, click I don't know and the installation will
be canceled. You will need to ascertain that information before the
installation can proceed.

4. If the Content Installer detects existing instances of SQL Server Reporting
Services installed on the local server machine, the following dialog will
display giving you the option to use the existing installation or to install a side
by side installation. 
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Option Description

Click here to start a side
by side installation of
SQL Server 2008 R2
Express

The side-by-side option is the recommended option to ensure
that all configuration changes needed for BizInsight purposes do
not interfere with other applications that may be using SQL or
Reporting Services.

Click here to use a
currently installed SQL
Server that you have
checked above

Use this button to specify that the installer use a detected
existing instance. Be sure to check the checkbox next to any
detected instance before using this button.

 IMPORTANT   If Sage 100 is using a 64-bit ODBC driver and an
existing 32-bit SQL instance is detected, do not choose that
existing instance. Instead, choose to do a Side-By-Side
installation of SQL Server. A 64-bit ODBC driver cannot be used
by a 32-bit SQL Server instance.
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Option Description

Click here to override and
enter your Sql Server
information

Use this button If you need to specify a different port or want to
use HTTPS for secure communications or your existing
installation is not detected.

When this button is clicked, a warning will display to emphasize
the requirement that the content installer must be run on a
server with a SQL database engine installed. Click OK to clear the
message.

In the Connection String for SQL Server field, enter a valid
connection string for the SQL Server instance to which the
Content Installer should install the SQL MetaData databases.
Use theWindows Authentication Example or the SQL Server
Authentication Example buttons to populate the connection
string with sample syntax. Be sure to change the values to
values valid for your environment.

In theWeb URL for Report Server field, enter theweb service
URL for the Reporting Services site to which Content Installer
should deploy the content RDLs.

If no Reporting Services Server is detected, the process automatically installs
SQL Server 2008 R2 Express with Advanced Services and uses “BIZNET” as the
default Report Server instance name.
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 IMPORTANT  IF an existing reporting services installation that you want to use
is not detected by the installer or you are not able to use the Override option,
contact BizNet Software Support for assistance.

If you get the following error after selecting the side by side installation,
verify that you have internet access.

If the side-by-side installation fails, contact BizNet Software Support for
assistance.

Once installation is complete, the Content Installer dialog will update to reflect that
a Report Server was found.
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Create Report Server User
The Create Report Server User option creates the currently logged in user account
as a new user in Reporting Services with the Content Manager role. This step is neces-
sary to ensure that the currently logged in user account has sufficient rights to
deploy datasets in the later stage of content installation.

NOTE  BizInsight end users will be assigned Reporting Services security by the License
Administration Tool.
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Create Linked Servers
Use this button to create ODBC data sources and Linked Servers for each Sage 100
company from which data will be retrieved using BizInsight. If you add a new com-
pany to Sage 100, you can come back to this button to get that new company setup
for BizInsight reporting.

1. You will work through this dialog starting with the Stage1 section (upper left).

a. Stage 1: Setup Driver
The installer will try to automatically detect the ProvideX ODBC driver
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If the driver is not found, click on the Browse button to browse to the
directory in which the driver is located. Or manually enter the path.

b. Stage 2: Database Location
The installer will try to automatically identify the location of the MAS90
company data directories.

 CRITICALLY IMPORTANT  If the detected database location is a UNC
path or a mapped drive path, you must go to Task Manager and end task
the Content Installer. See "Adjusting the Sage 100 ODBC paths" on page
119 for instructions on how to change the detected paths to a local
directory on the server. If this installation is being done on a server that
is not where the Sage 100 ProvideX data is located, you must perform
the installation on the Sage 100 data server.
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If the installer cannot find the directories, click on the Browse button
and browse to the directory that contains the SAGE 100 company
database directories (MAS_XXX). This location should be a local drive,
not a mapped drive or a UNC path.

c. Stage 3: Database Administration
Provide a SAGE 100 login id and password with rights to all companies
from which data will be retrieved using BizInsight. BizNet recommends
creating a login id for BizInsight reporting purposes and using this login
id instead of using an existing user’s login and password that could be
changed or deleted in the future.

d. Stage 4: Created File Details (Optional)
This section allows you to override the default file location and file
names that the tool can create for the next installation steps.
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e. Stage 5: Detect and Stage 6: Create
Use this section to automatically detect existing Sage 100 companies and
select which ones to setup for BizInsight reporting.
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The Check Database For Companies button will load all Sage 100
companies into the Stage 5: Detect pane.

The Add All Detected Company Codes button will add all detected
companies to the Stage 6: Create pane.

To add only certain companies for BizInsight reporting, check the
checkbox next to the company code in the Stage 5: Detect pane and
then click the Add Selected Company Codes button.
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Use the Clear Detected Codes button to start over.
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f. Choose OS Type
Select the appropriate radio button to indicate the bitness of the server
hardware, 32-bit or 64-bit.

g. Registry Entries and Linked Servers
Use these options to control the next installation steps. Make sure the
Create File option is selected. This will create files in the directory
specified in the Stage 4 section. You will execute these files yourself
when the content installer completes.

h. Click on the Start Process button.

You will received the following message when the Create Files option
is selected. Click Yes.

A Windows Explorer window will open to the directory containing the
files that were created.
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i. Open the CreateODBCDataSources.reg file with Notepad.

j. Search for pvxodbc.dll and check to see if there is a single back slash
preceding the file name or two back slashes. If there is only a single
back slash, do a search and replace of \pvxodbc.dll with \\pvxodbc.dll.

k. Save the file, being sure to preserve the .reg extension, then double-
click to create the ODBC data sources.
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l. Open SQL Server Management Studio (Start > Programs > Microsoft
SQL Server version > SQL Server Management Studio)
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m. Click on File > Open > File, browse to C:\ and select the
CreateLinkedServers.sql file.

If the following message is displayed, click Yes.
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n. Click Execute to run the script.

o. The BizInsight Content Installer only grants SQL sysadmin rights to the
user performing the installation. It is a good idea to add additional
administrative logins to ensure more users have sysadmin rights to this
SQL installation. The next steps describe how to add the built-in
Windows group "Domain Admins" with sysadmin rights as an example.
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p. Expand the Security node in the SQL Server Management Studio Object
Explorer. Right-click on Logins and choose New Login.

q. Click on Search.
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r. Click on Object Types and check the Groups checkbox. Click OK.
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s. Select your domain and click OK.

t. Type Domain Admins in the object name field, or the name of any
administrator user that should have sysadmin rights to the BizNet
SQL instance. Click OK.
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u. Select the Server Roles page and check the sysadmin checkbox.

v. Once completed, return to the Content Installer to continue with the
installation.
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Run Database Scripts
The Run Script Files button will only display if the BizContent product requires sup-
porting tables or other objects to be added in your accounting system database or a
separate BizInsight-use only SQL Server database. If there isn't a Run Scripts button,
you can move to the next step. As a standard practice, BizNet Software does not
make modifications to any base accounting system objects unless absolutely neces-
sary and will only be adding additional tables, stored procedures or triggers necessary
for data retrieval.

1. Click on the Run Script Files button to open the Scripts directory.

2. Open the "BizContentScriptReadMe.txt" file for installation instructions.

3. Click on Start > All Programs > Microsoft SQL Server version > SQL Server
Management Studio and connect to your software package database instance.
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4. Click on File > Open > File and browse to the Scripts directory and open the
first .sql file listed.

5. Check for instructions within the script in case there are variables that need to
be set to values specific to your environment. Make any necessary adjustments
and click Execute on the toolbar to run the .sql.

6. Close the .sql file.

7. Repeat these steps for each .sql file in the Scripts directory.

8. Close SQL Server Management Studio.



BizInsight 5.0.35.2 Installation Guide: Appendices

BizNet Software, Inc 190| Page

Deploy Data Set Content
This button can be used to deploy the reporting services reports to the Report
Server. 

Most values will be automatically completed for you in this dialog but the following
items should specifically be checked and confirmed to contain correct information:

a.  IMPORTANT  If you will be installing content packs for multiple back end
systems (example, , change the Default Reporting Services Folder Path to
something generic like “” to ensure the content is deployed to the same
folder.  Do this for each content pack being installed.  This is important
because BizInsight can be pointed to only one reporting services folder so
all content must be deployed to the same folder.

b. Skip this step if you are using Sage 100 ProvideX.
Adjust the Server Name field if your accounting system database is on
another server.
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c. Skip this step if you are using Sage 100 ProvideX.
Adjust the Database Name field to point to your accounting system
database.  If your accounting software uses a system or control database,
provide the name of that database rather than a company database name.

d. Skip this step if you are using Sage 100 ProvideX - data can only be
retrieved using Windows authentication.
Select the desired authentication method – Windows authentication or
Prompt for Credentials.
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e. Click Deploy Content to continue.

The Content Deployed Successfully dialog will open and display the Web
Service and the Report Manager URLs.  Click Close.

If you encounter an error deploying the DataSet Content, contact BizNet
Software Support for assistance.
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Deploy MetaData Content
This step will deploy .biz files and templates to the shared directory.  During this
step, the designated folder is examined for other biz files and the installer will eval-
uate whether merging of biz files is necessary.

When prompted, browse to the shared directory and click OK.

If you chose to create separate folders for the admin files and config files, choose
the config folder for the path.

Merging MetaData Scenarios

BizInsight stores application metadata in files with a .biz extension in the shared dir-
ectory (old design) or in SQL Server databases (new and recommended design). When
installing updated content or additional content, it becomes necessary to merge this
metadata. The the different scenarios requiring a merge of MetaData and how the
merge is handled by the Content Installer are described below.

Before proceeding, it is important to establish two key definitions:

l Legacy MetaData is defined as .biz files or SQL MetaData databases that have not
been processed or cleaned by the Content Packager (the tool used internally to
create a Content Installer package).

l New MetaData is defined as .biz files or SQL MetaData databases processed or
cleaned by the Content Packager. New .biz files contain three new columns.

When Content Installer merges MetaData, the below results will occur depending on
the scenario.
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1. Content Installer + New SQL Server Environment

l User installs a GL content pack.

l No .biz files are in the configuration path folder.

l Content Installer installs GL MetaData.

Result: New SQL Server MetaData databases are created in SQL Server
containing GL MetaData.
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2. Content Installer + Existing SQL Server MetaData Databases

l User installs an AP content pack.

l No .biz files are in the configuration path folder.

l SQL Server database already contains New MetaData from a previous GL
content install.

l Content Installer merges AP metadata into the GL metadata in SQL Server
database.

Result: Existing SQL Server MetaData databases contain GL and AP metadata.

3. Content Installer + Biz files in Config Path Folder

l User installs an AP content pack.

l Configuration path contains New MetaData .biz files for GL content.

l No SQL database exists for GL MetaData.

l Content Installer merges GL and AP MetaData into the SQL Server database.

Result: New SQL Server MetaData databases are created containing GL and AP
MetaData.

4. Content Installer + Previous install with AccessToSQL tool

l User installs an AP content pack.

l Configuration path folder may or may not contain .biz files.

l SQL Server database exists and already contains GL Legacy MetaData from a
previous AccessToSQL install.

l Content Installer removes the GL metadata from the SQL Server database.

Result: New SQL Server MetaData databases are created that contain only AP
MetaData. GL content must be reinstalled using a Content Installer.

 IMPORTANT  This merge scenario will result in the removal of all legacy
custom content (templates, custom functions or analysis sets).  These items
will need to be re-added after conversion is complete.  This process is a
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necessary step to ensure future custom settings are preserved and should not
be required again. See "Re-Create Custom Objects" on page 212 for instructions
on recreating custom content.

5. Content Installer + Legacy .Biz Files

l User installs an AP content pack.

l Configuration path contains GL Legacy MetaData .biz files.

l No SQL Server database exists for GL MetaData.

l Content Installer does not merge metadata.

Result: New SQL Server MetaData databases are created containing only AP
MetaData. GL content must be reinstalled using a Content Installer.

 IMPORTANT  This merge scenario will result in the removal of all legacy
custom content (templates, custom functions or analysis sets).  These items
will need to be re-added after conversion is complete.  This process is a
necessary step to ensure future custom settings are preserved and should not
be required again. See the section titled "Recreate Custom Objects" in the
Applying Updates document for instructions on recreating custom content.
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Deploy Function Content
During this step, the Content Installer deploys the .dll, .xll, and .dna files to the
shared directory. The path will be automatically filled in with the path used to
deploy the MetaData content.  If previous files exist in the directory, the files are
replaced with the new files.

Click OK to install the function content.
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Administration Tool
Use the Administration tool to add new BizInsight users or modify your existing
BizInsight license assignments.

1. Click on the Admin Tool button.

2. The License Administration Tool will open. Click on the browse button.
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Browse to the directory that contains the BizInsight license file.

3. Click the Validate License button to review the license information.  The
number of licenses purchased will be displayed.
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4. Click on the Configure Users button to add your BizInsight users and assign
them to a BizInsight user type (Developer, Designer, Viewer or Drilldown). 
Click Commit Changes when finished.

 WARNING  Do not add your own login using the Admin Tool unless you know
for sure that you have another login available with sysadmin rights to the SQL
Server instance. Early versions of the content installer (pre version 1.6) will
remove existing permissions for users, including those with sysadmin rights. If
uncertain, skip this step and confirm sysadmin access will not be lost then
return to complete the Admin Tool step.

IMPORTANT

To avoid errors when the License Administration Tool sets up security, be
sure to include the domain in front of the login ids.
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5. You will be prompted to assign the necessary folder permissions and Reporting
Services security to the users.  Click Yes.

Permission Details

The user will be granted Content Manager permissions to the Reporting Services root
level. In addition, the Admin tool will set the Share and Security permissions on the
specified config and admin folder locations.  The Share and Security permissions will
look like the following:
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When the admin files are in a separate folder, the security for that folder will be
more restrictive.
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Config Tool
Use this tool to configure default values for the BizInsight users. These settings will
be stored in an app.config file that can be copied to each user's workstation after
BizInsight is installed. Users will still be able to adjust these options to their own pref-
erences. When users adjust these settings, their adjustments will be stored in a user-
.config file in their profile and that file will be read first before the app.config file.

General Tab

The values shown in the General Tab should be automatically filled in by the Content
Installer with the pertinent paths for the BizInsight implementation. If user profiles
are remapped to network locations (instead of their local C:\ drive), use the Content
Path Override section to specify an alternate default local folder to which BizInsight
Scan for Content can copy the BizContent add-in files.
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User Experience Tab

Use this tab to manage various user experience settings for all BizInsight users. The
current settings are the recommended default values but can be adjusted as desired.
A brief explanation of each option is provided below.

Option Description

Show Large

Filters

When a user drills down on a function, the parameters used for the func-
tion are stored in a property of the analysis set. The field in which those
values are stored is limited to 255 characters. When the total length of
the string representation of the parameters exceeds 255 characters, the
string will be truncated to 255 characters. Use this option to store para-
meters strings that exceed 255 characters in a cell above the analysis set.
You will want to do this if you intend to keep the analysis set list in the
workbook and have it refresh on subsequent workbook refreshes. The
user would need to change the analysis set properties to point to the cell
containing the parameters. See section 3.8.1 Passing Parameters to Ana-
lysis Set Lists of the User Guide for instructions on how to point the ana-
lysis set to that cell.
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Option Description

Refresh Timer When the BizInsight right-click option to refresh a report is used, a dialog
can display at the end of the refresh with information on how long the
report took to refresh and how many functions were refreshed. Use this
option to turn that dialog on or off.

Caching Window BizInsight can be configured to display a caching window for each data
cache being built. .This feature is turned off by default.

 IMPORTANT  For Excel 2013 users, this option cannot be enabled if the
Formula Editor Pop-up option is enabled.
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Option Description

Formula Editor
Popup

This option can be used to control whether the Function Arguments dialog
automatically opens for a user when a function is dragged and dropped
from the BizInsight Navigation Pane into a worksheet.

 IMPORTANT  For Excel 2013 users, this option cannot be enabled if the
Caching Window option is enabled.

Expression Editor
Render Mode

The Expression Editor is a BizInsight feature that helps users construct
complex expressions for their functions parameters. This option exists to
allow customers to switch to hardware graphics rendering to address
usability issues with the Expression Editor dialog that may be caused by
the client workstation's video drivers.

Expression Editor
Start Up Page

Use this option to control whether the Expression Editor will start with the
Basic dialog or the Advanced dialog. BizNet Software recommends that
this setting be left at the default, Basic mode, for all users.
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Performance Tab

Option Description

XMLFast XMLFast is a feature that was added to BizInsight to improve data
retrieval performance. Data is retreived directly from the database
server using TCP/IP when this option is enabled. When this option is
turned off, the data retrieval is performed by Reporting Services and is
generally much slower. BizNet Software recommends leaving XML Fast
enabled.

Query Timeout When large data volumes are being retrieved, use this option to
increase the default timeout setting. The most common occurrence of a
timeout is during a drill down to transaction detail. If your company has
a large chart of accounts and significant transaction volume each
month, it is advised to increase this timeout setting.

Calculation Settings The Calculation Settings options allow you to control the scope of Excel's
recalculation of a workbook. Changing these options may result in
slower performance but may resolve situations when objects (functions
or Excel pivot tables) are not refreshed when a BizNet Refresh is per-
formed. BizNet Software recommends leaving this unchanged and
adjusting on an individual basis when necessary.
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Security Tab

Use this tab to specify what method of authentication will be used to for data
retrieval and for connection to the BizInsight MetaData databases (BizInsight and
BizInsightDB SQL databases).

Option Description

SQL Authentication Prompt If the BizInsight users will be using SQL credentials to con-
nect to the accounting system database, choose the top
option. When BizInsight first attempts to retrieve data for
an Excel session, the user will be prompted to provide
their SQL credentials and those credentials will be used
for all subsequent data retrieval calls as long as that Excel
session stays open.

The Ask for your data server credentials every time
option should be used when Windows authentication will
be used for all data retrieval calls made to the accounting
system database.
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Option Description

Meta Database Type Authentic-
ation

Use this section to specify whether Windows authen-
tication or SQL credentials will be used to retrieve data
from the BizInsight MetaData databases. This is a com-
pletely different data connection than is used for retriev-
ing data from the accounting system database. If the SQL
option is selected, a SQL login id and password must be
provided in the Application Settings dialog after BizInsight
is installed on the client workstation.  WARNING 
SQL credentials will be stored in clear text in the resulting
configuration file.

Regardless of whether you made changes, click on the Configure Now button to cre-
ate an app.config file that can be copied to each client workstation. Otherwise click
on Exit to close the configuration tool without creating an app.config file.
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Relevant Information
Click on the Relevant Information link in the upper right corner to view the import-
ant paths for your content implementation. 

Unless you used the Config Tool to create an app.config file, you will need to
provide this information during the BizInsight installation on the client workstation
(s).

If you chose separate folders for the admin and config files, the Relevant Information
dialog will look similar to the following:



BizInsight 5.0.35.2 Installation Guide: Appendices

BizNet Software, Inc 212| Page

Re-Create Custom Objects

l Custom Navigation Pane nodes. These items are most commonly templates. For
steps on how to re-add these custom nodes, refer to the section titled "Tem-
plates" in the User Guide. Ex:

 IMPORTANT  If BizInsight 5.0.35.1 or higher is installed, the Properties menu can be
used to assist in the retrieval of the following custom settings so they can be added
back to the new SQL MetaData files. See "Retrieving Custom Properties" on the next
page for instructions. NOTE  Custom Navigation Pane nodes cannot be retrieved
using the Properties menu.

l Any Account Definitions. ou should have a central workbook that contains your
account definitions. Just open that workbook and refresh it to recreate your
account definitions.
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l Custom pivot layouts. Custom pivot layouts are created using the Save Pivot Lay-
out option on the BizInsight right-click menu when a BizInsight created pivot lay-
out is right-clicked.

Retrieving Custom Properties
BizInsight 5.0.35.1 provides a Properties menu with an analysis set that can be used
to retrieve all custom settings such as Optimize Cache definitions, Account Defin-
itions and custom Pivot Layouts. To recover custom settings, do the following:

1. Make sure the .biz files containing the customizations reside in the
Configuration Path to which BizInsight is pointed.

2. Open BizInsight and click on the Application Settings button on the BizInsight
ribbon.
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3. If the Use settings fromConfiguration Path checkbox is checked, uncheck it.

4. Click on the Configure SQL button. If the dialog is filled in, take a screenshot
of the dialog so that it can be reinstated to original values. Then uncheck the
Use SQL Server for MetaData checkbox.

5. On the Application Settings dialog, make sure the Configuration Path is
pointed to the directory that contains the .biz files. The click OK to close. You
will be prompted to restart Excel.

6. Re-open Excel.
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7. Click on the Properties button on the Navigation Pane to display the Properties
menu.

8. Expand the AnalysisSets node then drag and drop the User-Defined Properties
analysis set.
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9. Right-click on the analysis set and choose Data Range Properties.
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10. Uncheck the Save query definition checkbox to make the analysis set static.

11. Click OK to the warning message that opens.

12. Click on the Offline button to take BizInsight offline.
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13. From the Functions node of the Properties menu, drag and drop a SetAcctDef
function and drop it in a column to the left of the analysis set. Add a column if
one is not already there.

14. Click on the Excel fx button to open the Function Arguments dialog for the
SetAcctDef function and pass in cell references for each of the parameters.
The column headers for the analysis set match up with the function parameter
names.
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15. Copy the SetAcctDef function down for all rows of the analysis set.

16. Save the workbook.

17. Go back to the Application Settings and Configure SQL dialogs and restore the
settings to the original values.

18. Close and reopen Excel.

19. Load BizInsight.

20. Open the workbook with the SetAcctDef formulas, right-click and choose
BizNet Refresh. This will create the properties in the new SQL MetaData
database.
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